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Overview

This user guide covers the following:

« Saving Files « Moving, Copying, or Deleting Files
« Naming Files o Locking and Unlocking Files

« Re-Naming Files or Folders « Using Versioning

e Finding Files & Search Filters « Viewing Version History

« Opening Files

See also QRG Box - Working with Files

Saving Files

Note: Box supports a maximum size of 5 GB for individual files. However, Ledcor uses an
enterprise version of Box with unlimited total storage, so you can upload as many individual
files (5 GB or less) as required.

Option 1: Drag & Drop
1. Navigate to the local drive where the files or folders are.

2. Navigate to the box location where to drop the files or folders:

« Web: To the Files and Folders screen.
« Box Drive: The folder location in file explorer.

3. Select the files or folders, hold, drag and drop them to the desired location.
Tip: Hold the CTRL key to select multiple files or folders.

Option 2: Upload @L

1]

1. Navigate to the location to upload the
files or folders.

2. Click Upload, and select Files or Folder.
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- Upload -

Files

Folder

Forfiles, a Choose File to Upload window is displayed.

a. Select the file(s), and click Open.
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For folders, a dialog box is displayed. 2 https://ledcor.app.box.com/?rm=box_v2_jav.. — O Kl

a. Drag and drop yOUI' ﬁleS tO the area Upload files to 1026217 - Zibi OC Infrastructure on Box Add files
inside the dashed line, or click Add PTTTTTTTTT T e e :
files and select your files. :

b. Click Upload. | 1--_;------~E

Drag and drop files here or
salect files by clicking ‘Add files’

W Skip hidden files and folders

Cancel

Don't see any folders?
H125% -

Option 3: Upload Directly from Outlook and other Office programs

(Box for Office required)

1. In Outlook, select an email message, or
open an email message. Save

2. From the Home tab on the ribbon, click Attachments
Save Attachments.

3. In the File Explorer, select the location and click Open.
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Choose File to Upload ﬂ
=
OH‘\- Canced
Naming Files
Give files meaningful names. Make them Examples:
descriptive and keep them simple - this will
make searching for them in the future easier. . Project Quality Plan: 1010500 PQP

Use elements such as: Job number, type of file, - Project Safety Plan: 1010500 PSSP
division, and date. « Operational Review Checklist: 1010500

ORC
« Subcontracts: 1010500-161000 App C
« Application for Payment: APP-4 SEP 17

Restrictions List of special characters:

Do not use special characters. Box Drive will
not sync files that use restricted characters in
the filename (these are restricted in Windows). « > (greater than)
« : (colon)

« " (double quote)

« / (forward slash)\ (backslash)

« < (less than)

Keep file names as short as possible, and use

abbreviations where possible. The full file path,
including the file name, must be 255 characters
or less in order to successfully sync using Box « | (vertical bar or pipe)
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Drive. « ? (question mark)

« * (asterisk)
Renaming Files or Folders

1. Navigate to the file or folder. Search Files and Folders

2. Hover over the file name until you see the
Rename icon.

Mame
RFP 05.xlsm [Vié

ﬁ? Request for Payment 1026217M.pdf

E Request for Paymem 1026217M.pdf

Iﬂ Payment Slemarv.pd

3. Enter the new file or folder name and .
click Okay. Rename file

Please enter a new name for the file.

Finding Files & Search Filters

For the best search experience, navigate to your project folder before doing a search.



BOX: Working with Files User Guide

1. Enter a keyword in the Search field. & [[toom |
2. Click the Filtericon and check the Only - ... Content Fiters o
search inside of “[current folder]” check- .
box. _
3. You can set additional filters: S

« File Type(s) ' Aoy Time

. Date Updated N :

R Owners Emvter 5 st WMES OF SMail Bodresses
4. Press Enter or click the Search icon.

Search results are displayed. G0 e

Search Results may be further refined by using the advanced filter:

« By Type: Audio, Box Note, Document, Drawing, Folder, Image, PDF, Presentation, Spread-
sheet, Video, 3D.

« By Size: 0-1 MB, 1-5MB, 5-25MB, 25-100MB, 100MB-1GB, 1GB+

« By Time: Any Time, Past Day, Past Week, Past Month, Past Year and Custom Range
« By Owner: Enter owner name

« By Folder: Navigate to desired folder

« By Metadata (Do not use)

« By tags (Do not use)

« Search Within: Everything, File and Folder Names, Comments, Descriptions, File Contents,
Tags.

bathroom E

Search Results for bathroom 1 of 15 »

Relevance

1D-3.9_DETAILS - BATHROOM CABINETRY pdf

All Files » Construction Projects » Projects » Ledoor 1010319 - 8X On The Park
DRAWINGS AND SPECIFICATIONS * Packages * Issued for Construction * 05 - IFC
Interior Design
A5 SPECIFIED AS NOTED 1D-3.92 DETAILS - BATHROOM CABINETRY CLIENT:
PROJECT #: 18-06-01/02 DRAWING:
SKETCH BATHROOM SOFFIT.pdf

[N
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Opening Files

« Option 1: From Box
« Option 2: From Box - Right-Click Menu
» Option 3: From Box Drive

« Option 4: From an Office Application

Option 1: From Box

You can either open files directly from Box or download a copy for local use (note that downloaded
files are not synced with Box).

1. From the All Files page, navigate to the file you want to open.
2. Click the file name (the filename is underlined when you hover over it).

Construction - Internal Only -

Mams Jatec =

(et | Vancouver @ Today by Maria Garz 181 Files

[ae| Calgary : Today by Conor Ste... 3,265 Files

M| US Today by Erin Ryan 9,840 Files

o] Toronto Today by Tony Earle 791 Files

[22] Edmonton Yesterday by Evan Zuk 17 Files

M| Regina Sep 18, 2017 by Nol 0 Filees

| | Documentl.docx| & : Sep 19, 2017 by Jae... 31 KB Share

A preview of the file is displayed.

3. Click Open, and if you have more than one program that can open the file type, select the pro-
gram you want to use (e.g. full desktop version of Microsoft Word or Microsoft Word Online).
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Corntruction - Infermal Only 3 Documentl.docx = (7] n Drormonibond m

% Micqeralt Word Ornline

Micrennlt Word

[Select Date]

INVOICE #1234
Mo Activity Yot
Bl To Ship To Comment and @maentisn peopbe
Cuastesmir [Crsstamar Nama] Recipsnt [Rucipient Hams] 0 oty tham
[ ———— y [T 1

4. If an Install Box Tools dialog is dis-
played, click Download and follow the
prompts to install Box Edit. Click Open

Install Box Tools

Box Tools for Windows

agaln' Onee installed, simply click the same
"Open™ button that brought you here and
The file opens in your local application. your file will apen on your computer

. foer makis wr nge wr il
Note: If you click Download to download Aftermaring your changes, save vour fie

a5 you normally would and the file on Box

a Copy Of a ﬁle to yOUI’ Iocal CompUter, will b automatically updated.
make sure to click ... (More Options)
> Upload New Version when you upload oo M s

the modified file to Box. See Using Ver-

sioning.

Option 2: From Box - Right Click 3 [.= s | P |
Optic o= CXZEI

" Share

| Prologindex § @bedcor.com) M Excel Caline
T Upload Miw Version
You can open files in Box using the right-click  [i] #rowgisensa @ O Downtosd Now 16, 2017[by
menu, allowing you to select the application to 2 Favorie
k| Subcontract Inguery 1213082 Howiser b Mo 18, 201 7| by
use. [ Move or Copy
8 wil Building Dedign and Condtrsction - e
= & LEED V4, Scorecard 5 Lock
1. From the All Files page, navigate to the & B Croarations and Msintama _
ﬁle you Want ‘to open_ i & LEED W4, Scorecard = Properties = !
. . Wl Commnarcial Invberior (IDC) Soan o o A i - ..
2. Right-click the file, hover over Open fy CTESEMEREIREORS T Mare At B Now
with..., then select the application you want
to use.
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Option 3: From Box Drive e ———

1. Open the Box Drive Folder.

2. Navigate to the file you want to open, o =
then double-click to open it. o

Option 4: From an Office Applic-
ation

1. Click File > Open.
2. Select Box.

Open

C'—:,‘l Recent

Box

;3- Shared with Me

& OneDrive - Ledcor Industries Inc.
&ledcor.com

@ Sites - Ledcor Industries Inc.

@ledcor.com

Account

oﬁ OneDrive

Feedback

f-E&  Other Web Locations
Options =

] ThisPC

o= AddaPlace

Browse

3. If this is your first time opening a file through an Office application, click Sign in.



Open
I';T-} Recent
Bax
Shared with Me

Mark.Lister@ ledcor.com

Sites - Ledcor Industries Inc.

Mark. Lister@ledcor.com

P B ®

OneDrive

OneDrive - Ledcor Industries Inc.
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Open from Box

Sign in

Lkse Bow bo share your files with ampone, and take your files with you arywhere,
Lﬂll'l Mo
5Igl‘| n

4. Click Single Sign on, then enter your

email address and click Authorize.

5. On the Ledcor Login page, enter your
email address, and Password field, then

click Sign in.

Note: You only need to sign in to Box the
first time; subsequently you will be able to
go directly to browsing files in Box.

Log in to Box

0'0)'¢

a

Log in to grant access to Box

= @ledcor.com

Authorize

Use Box account credentials

Forgot password

-10 -



6. Click Browse Box.
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Open from Box

o

Browse
Box

Signed in as - Account

Version: 1.0.0.0

7. In the Open from Box dialog box, navigate to the file you want to open, select it, and click

Open.

Open from Box

& # |3 Construction - Internal Only

Date Modified
9/26/2017 3:21:34 PM

9/25/2017 3:53:03 PM
918720017 3:21:.50 PM

Name
(a8 Caigary
31 Edmonton
(2 Regina
(28] Toronto
Laus

-

S8 Vancouver

8/26/°2017 23742 PM
32672017 3:16:25 PM
9/19/2017 3:38:17 PM

92672017 123538 PM

[w] Display supported types only

Moving, Copying, or Deleting Files

To Move or Copy files or folders:

1. Select the files or folders.
2. Click Move or Copy.

To Delete files or folders:

-11 -



1. Select the files or folders.

2. Click Trash.

-
Search Files and Folders
B3 Al Files Meetings is selected

Meetings

Estimate

Using Versioning

BOX: Working with Files User Guide

E] P
[ ] [T ]
6 Nodar
° PACE
@ Cons ]

Each time afile is saved, a new version of it is saved. The following example shows that the file
titted RFP has 16 versions. This information is also displayed in the Details tab.

Search Files and Folders

RFP 05.xlsm is selected

Package - Back up
JOE Reports
CROWMergeTemp

| RFP 05.dsm [F15]]

File Properties

Sep 14, 2017 by Alliso... 173.7 KB | === Share

Molan Smith

To save new versions of existing files, choose one of the following two methods:

Option 1: File Name

1. Save the files with the same name as the original file. This automatically creates a new ver-

sion.

Option 2: Upload New Version

1. Select the file.
2. Click More Options (...).

3. Select Upload New Version.

-12 -
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4. Find the saved file and click Open.

Note: If the file name is different, the new version will have the new file name. Versions
will be preserved with the old file name.

Appendix E - Subcontract Price Analysis.xlsx is selected 1 Send Items 4 Download
Marme Updated Size =
-_‘ Bid Form.docx Aug 24, 2017 by Keely Hatton 35.6 KB
0 Appendix F - Insurance (Wrap - Canada). docx &z Aug 24, 2017 by Keely Hatton 4B.8B KB
¥ 3 Appendix E - Subcontract Price Analysis.xlsx Aug 24, 2017 by Keely Hatton 294 KB D Share
1| Appendix D - Schedule of Work.docx Aug 24, 2017 by OPenwith..
(? Share
" Appendix B - Subcontractor General Obligations (Canada).docx Aug 24, 2017 by @ Upload New Version |
2 Download

TT Faverite
O Move er Copy

B Lock

Properties
© More Actions

1 Integrations

Locking and Unlocking Files

You can lock individual files on both the Box website and Box Drive to avoid conflicts when mul-
tiple users want to work on a particular file.

Locking a file in Box

1. Click More Options (...), then select Lock.

Prologindes.sdsx [z Mowv 148, 2017 k& D

Opeier with,

Ty

Subcantract Inquiry 1213082 Hauser.pdf Mov 16, 2017t ¢ Share

1t I i
vd Building Design and Construction [BD+C) Scorecard. xls = Upload New Version

& LEED V4, Scorecard

U Download
vi Building Operations and Maintenance (EBOM) Scorecard.xdsx (F Mov 17, 201 T Eavorite
& LEED V4, Scorecard
B MoveorcCo
U vid Commercial Inberior (ID+C) Scorecarnd.xlox ) M 17 "
=1 ¢ LEED V4, Scorecard - B Lock
M i for HOMES Multi-family Midrise Scorecard.xlsx ~

-13-
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The Lock File dialog box is displayed.

Lock File

Lock duration: | (MGG -

Disable download

2. From the Lock duration drop-down, select the length of time to lock the file (generally, the
length of time you plan to be working on the file).

3. (Optional) To prevent others from downloading a copy of the file being locked, select Disable
download.

4. Click Lock.

A "File successfully locked" message is briefly displayed, and a red lock icon is displayed
next to the file. Hover over the lock icon to see who has locked the file - contact the person to
request the file to be unlocked.

Prologlndex (f @ledcor.com).xlsx |2| Ll 2017 by P 13.5 KB
Indefinitely locked by you

Prologindex.xisx (V2] [@] Novis 2017 by N 13.3 KB

Unlocking a File in Box

1. Do one of the following:

« (1) Click the red lock icon, then in the Unlock File dialog box, click Unlock, OR
« (2) Click More Options (...), then select Unlock.

-14 -



Prologindexadsx [v2 |

L%
de

Subcontract Inquiry 1213082 Hauser.pdf

wi Building Design and Construction (BD+C) Scorecard.xls

& LEED V4, Scorecard

U vd Building Operations and Maintenance (EBOM) Scorecard.xlsx

& LEED V4, Scorecard

[ﬁ] vid Commercial Interior (ID+C) Soorecard. xlsx
==l ¢ LEED V4, Scorecard

wi for HOMES Multi-family Midrise Scorecard.xlsx

& LEED V4, Scorecard
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Mav 16, 2017 by Mark Lister 133 KB

Owpen withe.

LC4

Share

Upload Mew Version
Download

Favorite

Mowve or Copy

A "File successfully unlocked" message is briefly displayed, and the red lock icon is

removed.

Locking a File in Box Drive

1. In your Box Drive folder, right click the file you want to lock and select Lock File.

A notification appears in your system tray briefly, and the file icon is displayed with a gray

lock icon.

@lSubcantract Ingquiry 1213082 Hauser.pdf

Unlocking a File in Box Drive

In your Box Drive folder, right click the file you want to unlock and select Unlock File.

A notification appears in your system tray briefly, and gray lock icon is removed from the file

icon.

Viewing Version History

Box maintains a history of up to 100 versions for each file. You can view previous versions and rein-
state any previous version as the current version of a file if required. Comments entered directly in
Box notes by collaborators are part of the file and are always available.

To view version history, choose one of the three following methods:

-15 -



Option 1: Version icon

1. Click the version icon next to the file
name.

QRG Working With Fi|I:"‘_-.I'_|f_'|LK

Option 2: Details pane

1. Select the file.

The Details tab displays the number of
Saved Versions.

2. Click the hyperlink: (#) Saved Versions
to view the Version History.

Option 3: More Options menu (...)

1. Select the file.

2. Click More options (...) > Properties >
Version History.

You can do any of the following for a version of
a document:

« Download - Download a copy

« Make Current - Make this the current
version

« Remove - Delete this version

BOX: Working with Files User Guide

Version History

~ wis RFP OS5.xIsm ENED

Uploaded on Thursday, September 14, 2017 at 10:5% AM by
Allison Parsons.

Download

% w15 RFP 05.xlsm

Uploaded on Thursday, September 14, 2017 at 10:45 AM by
Allison Parsons.
Remaove

Download Make Current

% w14 RFP 05.xlsm

Uploaded on Thursday, September 14, 2017 at 10:37 AM by
Allison Parsons.
Remove

Download Make Current

Close

-16 -
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